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Pasting Content 

By default, Word preserves the original formatting when content is pasted into a 

document. The original formatting can bring in styles that can unintentionally 

conflict with styles in the HHS templates. To avoid problems with formatting, paste 

the following way: 

1. Right-click where the content needs to be pasted. 

2. A contextual menu will appear with several Paste Options. 

3. Select Keep Text Only. 

 

For more information on how to apply styles to text read How to Use HHS Word 

Templates. 

https://accessibility.hhs.texas.gov/docs/template-instructions.pdf
https://accessibility.hhs.texas.gov/docs/template-instructions.pdf
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Style Problems 

Missing Styles 

If the style you need to use is not in the template you are using, chances are your 

document is using the wrong template. You need to check which template is 

attached to your document: 

1. Go to the HHS Reports tab. 

2. In the Structure group, click the Templates command. 

3. Review the file name in the Document template field to confirm the 

template you are using. 

 

4. If you do not see the appropriate template, review Attach a Template to an 

Existing Document. 

Incorrect Fonts and Colors 

In the Reports template: 

● Heading 1s use Rockwell font. 

● Headings 2 – 4 use Verdana font. 

● Headings and Hyperlink styles are varying shades of blue. 

https://accessibility.hhs.texas.gov/docs/template-instructions.pdf
https://accessibility.hhs.texas.gov/docs/template-instructions.pdf
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In the General Documents templates: 

● All Headings and other styles use Verdana font. 

● Heading 1 is black.  

● Heading 2 – Heading 6 and Hyperlink styles are varying shades of blue. 

In the Newsletter template: 

● All Headings and other styles use Verdana font. 

● Heading 1, 3 and 4 are varying shades of blue. 

● Heading 2 is black.  

When attaching an HHS template to an existing document, color or fonts in a theme 

may not come in as expected. A theme is a tool to make the three features of your 

document consistent: 

1. The font used for headings. 

2. The font used for the body of the document. 

3. A color scheme—in our case, the HHS Brand colors. 

When this happens, apply the appropriate theme. 

1. Go to the Design tab. 

 

 

2. Click on Themes command. 
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3. In the Custom section, there are two document themes: HHS Basic Theme 

and HHS Reports Theme. Click on the theme to apply it to your document. 

 

When the colors are still incorrect review the next section, Incorrect Style Colors. 

Incorrect Style Colors 

In the Reports template, Headings and Hyperlink styles are varying shades of blue. 

In the General Documents templates, Heading 1 is black. Heading 2 – Heading 6 

and Hyperlink styles are varying shades of blue. 

In the Newsletter template, Heading 2 is black. Heading 1, 3 and 4 are varying 

shades of blue. 

When the colors for those styles are showing incorrectly in the Styles pane: 

1. Go to the Design tab. 

2. Click on the Colors drop-down arrow. 

3. Click on the HHS Branding Palette. 

 

When you look at the Styles pane, the colors recently applied should show up. If 

you wish to confirm the colors are correct, go to the HHS Word Template 

https://accessibility.hhs.texas.gov/docs/word-template-specifications.xlsx
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Specifications [XLS workbook]. It contains the red, green, and blue color values for 

all templates. 

Broken List Style 

List styles can break when: 

● Attaching an HHS template to an existing document. 

● Many people are working on a file in SharePoint. 

You can tell you have a broken list style because: 

● The bullet or number graphic is missing from the Styles pane. Or, 

●  The indentation of text in the list is different. 

One way to confirm you have a broken list is: 

1. Ensure the Show Preview checkbox at the bottom of the Styles pane is 

checked. 

2. If the bullet or number graphic is missing from the List Bullet style or List 

Number style, you have a broken list. 

NOTE: You can avoid this situation by always starting a new 

document from an HHS template. 

https://accessibility.hhs.texas.gov/docs/word-template-specifications.xlsx
https://accessibility.hhs.texas.gov/docs/template-instructions.pdf
https://accessibility.hhs.texas.gov/docs/template-instructions.pdf
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Here is an example showing broken list style in the Styles pane. 

 

 

And the result displayed in the content (bulleted list is missing the bullet graphics). 

To fix the issue: 

1. Apply the list style you need to fix. Following the example above, we will use 

the List Bullet style that does not have the bullet graphic. 

2. Place the cursor in the list. 

3. Go to the HHS Reports tab. 
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4. Click on the Multilevel List command in the List Level group. 

 

 

5. A menu will appear. In the List Styles category, select the appropriate style. 

The custom list styles are: Appendixes, HHS Bullets, HHS Heading 

Numbering, and HHS Numbering. In this example, click on HHS Bullets. 
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The List Bullet style now has a bullet graphic. The list style is fixed! 

 

Lists are Images in Adobe Acrobat Pro DC 

The following list styles can convert as images in Acrobat:  

● Numbered headings in the Reports template. 

● List Bullet and List Number in all templates.  

Using the list styles identified do not always result in this issue. 

You may see an issue after you convert to PDF and run the Accessibility Checker. 

To determine if you have this issue: 

1. The Alternate Text section will show an issue. Open that section. 

2. Other elements alternate text section will show as Failed. Open that 

section.  

3. Click on the Element to highlight the content that is a problem.  
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Be sure to click on the Element to confirm this issue applies to lists. In this 

example, I have clicked on Element 1 which highlights the number 1 in the list. 

You may notice the numbers look a little fuzzy. 

The source of the issue is in Word. To fix the issue: 

1. Save a copy of the file to your desktop (This prevents Word from crashing). 

2. Go to your Word document. 

3. Click on the number in the list causing problems. 

4. Press Ctrl+Space. 
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Table Problems  

Layout Table Instead of Data Table 

Use tables only for presenting data, not for layout or formatting. 

The example below is one instance where a different presentation is appropriate. 

Volleyball Volleyball is a team sport in which two teams 

of six players are separated by a net. Each 
team tries to score points by grounding a ball 

on the other team's court under organized 
rules.[1] It has been a part of the official 

program of the Summer Olympic Games 
since Tokyo 1964. 

Volleyball Wikipedia 

Football Football is a family of team sports that 
involve, to varying degrees, kicking a ball to 
score a goal. Unqualified, the word football 

normally means the form of football that is 
the most popular where the word is used. 

Football Wikipedia 

Baseball Baseball is a bat-and-ball game played 
between two opposing teams who take turns 

batting and fielding. The game proceeds 
when a player on the fielding team, called 
the pitcher, throws a ball which a player on 

the batting team tries to hit with a bat. 

Baseball Wikipedia 

Instead, format the content with a section heading and paragraphs as in the 

following example content. 

Volleyball 

Volleyball is a team sport in which two teams of six players are separated by a net. 

Each team tries to score points by grounding a ball on the other team's court under 

organized rules.[1] It has been a part of the official program of the Summer 

Olympic Games since Tokyo 1964. Volleyball Wikipedia 

Football 

Football is a family of team sports that involve, to varying degrees, kicking a ball to 

score a goal. Unqualified, the word football normally means the form of football that 

is the most popular where the word is used. Football Wikipedia 

https://en.wikipedia.org/wiki/Volleyball
https://en.wikipedia.org/wiki/Volleyball
https://en.wikipedia.org/wiki/Volleyball
https://en.wikipedia.org/wiki/Volleyball
https://en.wikipedia.org/wiki/American_football
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Baseball 

Baseball is a bat-and-ball game played between two opposing teams who take 

turns batting and fielding. The game proceeds when a player on the fielding team, 

called the pitcher, throws a ball which a player on the batting team tries to hit with 

a bat. Baseball Wikipedia 

Inappropriate Use of an Image to Present 

Tabular Data 

Presenting tabular data using an image of a table is almost never appropriate! 

Except, when you want a visual example. In this situation, the information in the 

table is not necessary for the audience to know. 

Insert a data table using the Insert Table command. 

Table Is Too Wide 

In the example below, the header row of the table is formatted incorrectly. 

Headin

g 

Headin

g 

Headin

g 

Headin

g 

Headin

g 

Headin

g 

Headin

g 

Headin

g 

Headin

g Total 

Text 133 435 345 134 234 452 346 356 2435 

Text 101 407 426 388 256 323 500 269 2670 

Text 125 241 487 498 124 222 437 354 2488 

Text 243 383 214 363 233 244 209 423 2312 

Text 150 366 478 467 205 425 322 311 2724 

Text 450 446 453 423 321 377 228 674 3372 

Text 375 352 324 401 206 657 549 506 3370 

Text 125 317 411 312 213 600 417 303 2698 

Text 280 472 597 288 182 807 538 344 3508 

Total 1582 3419 4035 3274 2274 4107 3546 3540 2577

7 

https://en.wikipedia.org/wiki/Baseball
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Method A 

To fit the data correctly in the table, clear any style applied to the table content. 

1. Select the table. 

2. Go to the Styles pane. 

3. Click the Clear All style. 

 

The table is now formatted correctly as shown in the following example. 

Heading Heading Heading Heading Heading Heading Heading Heading Heading Total 

Text 133 435 345 134 234 452 346 356 2435 

Text 101 407 426 388 256 323 500 269 2670 

Text 125 241 487 498 124 222 437 354 2488 

Text 243 383 214 363 233 244 209 423 2312 

Text 150 366 478 467 205 425 322 311 2724 

Text 450 446 453 423 321 377 228 674 3372 

Text 375 352 324 401 206 657 549 506 3370 

Text 125 317 411 312 213 600 417 303 2698 

Text 280 472 597 288 182 807 538 344 3508 

Total 1582 3419 4035 3274 2274 4107 3546 3540 25777 
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Method B 

Switch the page layout into landscape orientation to spread out the content. 

Table 1. Example of Landscape Orientation with Notes 

Heading Heading Heading Heading Heading Heading Heading Heading Heading Total 

Text 133 435 345 134 234 452 346 356 2435 

Text 101 407 426 388 256 323 500 269 2670 

Text 125 241 487 498 124 222 437 354 2488 

Text 243 383 214 363 233 244 209 423 2312 

Text 150 366 478 467 205 425 322 311 2724 

Text 450 446 453 423 321 377 228 674 3372 

Text 375 352 324 401 206 657 549 506 3370 

Text 125 317 411 312 213 600 417 303 2698 

Text 280 472 597 288 182 807 538 344 3508 

Total 1582 3419 4035 3274 2274 4107 3546 3540 25777 

If placing the table in landscape orientation does not solve the problem and the information must be in a table, then split it into 

smaller tables. 



16 

Change Page Orientation  

Large images and tables may fit better when you change the page orientation to 

landscape. In the following example, the page orientation changes from portrait to 

landscape. 

1. Work in Show All mode to see the page breaks. 

2. Go to the HHS Reports tab and click on the Show All command in the 

Structure group. 

 

 

 

3. Place the cursor where the first page break needs to go. 

4. Go to the HHS Reports tab. 

5. Click on the Breaks command in the Layout group. 

6. A menu will appear. In the Section Breaks category, click Next Page. 

A page break is inserted.
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7. Follow steps 3 through 6 to insert a second page break. Insert the page 

break after the content that needs to be in landscape orientation. 

8. Place the cursor in the content that needs to be in landscape orientation. 

9. Go to the Page Setup group in the Layout tab. 

 

 

10.Click on the Orientation command. 

11.A menu will appear. Click Landscape. 
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Page Breaks Changing in Quick Parts 

Are the page breaks in your document changing when you use Quick Parts? This 

can sometimes happen when you have attached a template to an older document. 

To avoid this situation: 

1.  Start a new document.  

2. Then copy your content into the new file using the Keep Text Only paste 

option. 

See the Pasting Content section for more information. 

https://accessibility.hhs.texas.gov/docs/template-instructions.pdf
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Page Numbering Gone Wrong 

Section Page Breaks are the Problem 

In a section of your document, page numbering has restarted or is out of order. 

This can happen when using Section Page Breaks in a document. 

Page breaks are used to: 

● Break apart different topics. 

● Change page orientation. 

Remove as many page breaks as possible to resolve the page numbering 

issue.  

Check Footer Settings 

If page numbering is still wonky check Footer settings: 

1. Double-click in the footer area at the bottom of the page. The Header and 

Footer tab opens.  

Focus moves to the footer, where you should see three pieces of information: 

A. The number of the current Footer section. 

B. If the footer is the same as the previous section. 

C. The page number. 

 

 

2. When you don’t see the Same as Previous setting in your Footer: 

A. Go to the Header & Footer tab Navigation group. 

B. Click on the Link to Previous button. 
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A dialog pops up asking “Do you want to delete this header/footer and 

contact to the header/footer in the previous section?” 

 

 

 

C. Click on the Yes button. 

If that doesn’t solve the problem, go to Step 3. 

3. You are still in the Footer. Right-click on the problem page number. 

4. A menu opens. Click on the Format Page Numbers…button. 

5. The Page Number Format window opens. The Page numbering section has 

two radio button options, Continue from previous section and Start at. 

Choose the one that fits the situation best. 

6. Click on the OK button. 

Page numbering is no longer wonky!! 
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